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INTRODUCTION

Congratulations on your purchase of the Option GlobeTrotter card.

GlobeTrotter together with the GlobeTrotter Mobility Manager software is the ultimate
high performance solution for providing mobile wireless connectivity to Laptops
and Notebooks. The GlobeTrotter solution enables users to browse the Internet,
send and receive e-Mails, send and receive SMS text messages and all with SIM

management seamlessly integrated with Microsoft Outlook™.

The technology in your Option GlobeTrotter card supports real time remote connectivity
and is ideal for the synchronization of mobile devices with the office or home computer.
GlobeTrotter is designed to support IPsec client software providing secure remote P
mobile access to corporate networks.

This guide describes how to install the GlobeTrotter Mobility Manager (GTMM)
software on your PC and how to start using it. For more detailed information,
consult the GTMM Online Help Guide.

Contents of the sales package

In the sales package, you will find the following items:
> Option GlobeTrotter card

> A CD-Rom containing the software

To overcome any installation and usage barriers and to enhance the user experience,

the following documentation is also included:

> This Quick Start Guide, which gives the installation of the GlobeTrotter Mobility
Manager Software in a limited number of steps, and assists the user in making
his/her first data call

> Online User Manual, which describes a number of common usage scenarios. The online

User manual can be accessed at all times through the Help menu of the software.

SYSTEM RERUIREMENTS (MINIMUM REQUIREMENTS)

The GlobeTrotter Mobility Manager software requires:

Processor

> Client (a computer not working in a server capacity): Min. go-megahertz (MHz)
Intel Pentium Il-class processor or higher

> Server (a computer working in a server capacity): Min.133-MHz Intel Pentium-

class processor

Operating System
> Windows XP Professional
> Windows XP Home Edition
> Windows 2000

> Windows ME

> Windows 98SE

Memory
> Client: 64 megabytes (MB) of RAM, 96 MB recommended
> Server: 128 MB of RAM, 256 MB recommended

Hard Disk
Min. 40 MB for installation of SW & Drivers

Display
800 x 600 or higher-resolution display with 256 colors

Input Device

Microsoft mouse or compatible pointing device



SYSTEM RERUIREMENTS (MINIMUM REQUIREMENTS)

Other requirements

> Microsoft Internet Explorer 6.00 or later

> The latest Windows service packs and critical updates from the Windows Update site.

> The target system may not have any version of the ‘Funk Odyssey’ WLAN client
installed, otherwise the installation will fail

Please refer to the GlobeTrotter datacard Product Sheet for datacard system requirements.

Network services

To use your Option GlobeTrotter card, you must first activate an account with a mobile
phone Service Provider and have received a Subscriber Identity Module (SIM) card.
Often the GlobeTrotter is supplied as a package with an airtime agreement. If you do
not already have an airtime agreement, please ask your supplier about obtaining one
for a compatible network. Please refer to the GlobeTrotter datacard Product Sheet
which will detail the types of network and services it is compatible with.

Some service providers may not provide all communications services. Contact your
service provider for further information about the availability and details of the services
in your home network.

Additional information may be required from your service provider to activate

the data functionality of the Option GlobeTrotter card such as:

> User Name - if applicable

> Password - if applicable

> Access Point Name (APN)

> IP Address - if not dynamic

> DNS Address - if not dynamic

SYSTEM RERUIREMENTS (MINIMUM REQUIREMENTS)

Communications software

When you run the installation program, the following programs will be installed on
your computer:

> Windows GlobeTrotter device drivers

> The GlobeTrotter Mobility Manager

The GlobeTrotter Mobility Manager
The GlobeTrotter Mobility Manager GTMM simplifies SMS messaging and the

configuration of GPRS settings for applications such as downloading e-mail or
browsing the Internet. It also gives the possibility to manage a WLAN connection.
The GTMM application incorporates a powerful SMS editor and a viewer for reading
SMS messages. Incoming and outgoing messages are listed in Outlook™-style directories.
The Setup page gives users a quick and easy way to set up any type of connection
(GSM, GPRS or 3G).

The WLAN page gives users a quick and easy way to scan and connect on a WLAN
network.



INSTALLATION

This section provides step-by-step instructions on how to install the Option

GlobeTrotter card on your PC.

NOTE: There are some slight differences in the installation process between
Windows 2000 and XP Pro/Home Edition. If the installation differs from the steps

described in this section, follow the instructions on the screen.

If you want to quit the Setup program without installing or uninstalling, click Cancel
and then Exit Setup to quit Setup. If you want to return to the Setup program after
having quit the installation before it was completed, follow the installation steps as

if you were installing the program for the first time.
Installing the Option GlobeTrotter card and the GlobeTrotter Mobility Manager

WARNING! DO NOT INSERT THE CARD!!

It is advised to connect your PC to the mains, before starting the installation

1. Start Windows.

2. Close all applications.

3. Insert the CD-Rom into your computer’s CD-Rom drive. If auto play is enabled
the setup will start automatically.

4. If this does not happen, select the Run command from the Start menu.

5. Select the drive that contains the CD. Go to D:\MobilityManagerSetup*.exe
(D: represents the CD-Rom drive).

6. Click OK to execute the file.

7. Select the language you want to install the program in.

8. The installation will start.

9. The software will automatically be copied into Program Files\OPTION\Mobility

Manager. Another target folder can also be chosen during the installation process.

INSTALLATION

10. At the end of the installation you will have to reboot the PC and if you have selected
automatic start up, the GTMM application will start up after the reboot.

1. Insert the Option GlobeTrotter card into the PCMCIA slot of your PC.

12. Wait until the system has recognized the card.

13. You will now be asked to register the product.
Registration is required to benefit from the warranty and customer care.
By connecting to the Internet you can register online immediately

at http://www.option.com/registration/4_3_registration.shtml

Choose Cancel if you want to register later. You will be able to start the registration
from the help menu in the main interface. When you click cancel each time you
start GTMM you will be asked to register.

Uninstalling the Option GlobeTrotter card and the GlobeTrotter Mobility Manager

1. Go to the Control Panel of the operating system.

2. Open Add/Remove Programs.

3. To uninstall the GlobeTrotter card and the GTMM software, select GlobeTrotter
Mobility Manager and click the Remove... button. Follow the steps of the
uninstall wizard.



GETTING STARTED

Starting the Option GlobeTrotter card.

Slide the SIM card into the SIM card slot of the Option GlobeTrotter card and insert
the Option GlobeTrotter card into the PC Card slot of your computer. It is recom-
mended to insert the card in the top PCMCIA slot. You may have to enter the PIN

(Personal Identity Number) code if the PIN code request is activated in the SIM card.

The PIN code is usually supplied with the SIM card. If you enter an incorrect PIN
code three times in a row, you will need a PUK (Personal Unblocking Key) code to

unblock the SIM card. If this doesn’t work, contact your service provider.

Using the GlobeTrotter card for SMS and Phonebook management

During the installation of the GlobeTrotter Mobility Manager software a link is created
in the Startup folder. GlobeTrotter Mobility Manager will subsequently start every time
the computer is turned on. The GlobeTrotter Mobility Manager icon then appears in the
task bar. If the GlobeTrotter Mobility Manager software does not start automatically
when the computer is switched on, or if the GlobeTrotter Mobility Manager program

has been closed in the meantime, it can be started again from the Start menu.

Once the program has started, the PIN code will be Fruerzaton &4
requested (if the PIN code request is activated on the SIM Erdes BN o
card) in order to activate the Globetrotter card. The card =

; . 1 2 3
will subsequently be registered onto the network. -

4 5 8

If the PIN code request has been disabled, the = 0 s
GlobeTrotter card will be registered on the network as il ' "
soon as it is powered on. [cmea ]

At the end of the network registration the GTMM inter-
face will open and you are ready to start a connection.

GETTING STARTED

The GlobeTrotter Mobility Manager Home Page

Connectivity
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The Home Page is the place where you have a complete overview on everything
that the GlobeTrotter Mobility Manager can offer.

From the Home Page you can:
> Access every section of GlobeTrotter Mobility Manager (the Toolbar)
Access every subsection (the Navigation bar)

>
> View the status of the registered mobile network and Wireless LAN
> View the indication of unread SMS

>

Quick launch a connection

In case you have unread SMS, these will be shown in the GTMM Home Page.

The indicator will show you the number of unread messages.

From the Home Page, you have the possibility to connect directly to an available
network. Once you have created or imported a connection profile, this will be listed
on the Home Page if the network (GSM/GPRS/UMTS/WLAN) is available.
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The SMS Centre

You can access the SMS center:

> From GlobeTrotter Mobility Manager Home Page by clicking:
- the SMS button on the top toolbar
- theicon next to the “You have received n SMS messages” text
- the SMS icon on the upper left navigation bar
> By clicking the “SMS envelope” icon in the systray. This is as a result of the system
having recognized that a new SMS message had arrived.

The SIM or Outlook address book will be shown when clicking on the respective icon.

By clicking on the Synchronize button (icon with the two arrows) you can synchronize your
Outlook contacts with your GTMM contacts. The Synchronize button will force GTMM to
(re)import the Outlook contacts. This action deletes all the current contacts held in GTMM.
This is useful when you have updated Outlook contacts independently of GTMM.

GETTING STARTED

You can read, create, reply, forward and delete an SMS by clicking the icons on the SMS
Message Management Bar, which is located at the bottom of the GlobeTrotter
Mobility Manager SMS Page

The Phone book

The available phonebooks are:
> SIM Phonebook
> Outlook contacts (if Outlook is present)

Contacts are read on the fly, which means that no duplicate phonebooks or synchronization
is necessary. The software will operate directly on the SIM and on the Outlook contacts.
You can edit the name or phone entry in the SIM contacts by right click on the SIM
contacts and select new or by going to ‘File/New/SIM contact. Then you get the

following popup window where you can edit your contact.

Number: | +3216317411

You can edit the name or phone entry in the Outlook contacts by going to
‘File/New/Outlook contact’. Then you get the standard Outlook window to make

a new contact.

You can also create new, cut, copy paste either the SIM contacts or the Outlook

contacts by clicking on the icons in the “SMS Message Management Bar”.



GETTING STARTED

Setup
The Setup page allows you to create, edit and configure a GPRS, GSM or UMTS connection.
Also, when a connection is present, this can be started from there.

In the top of the screen you have a list of all available connections.

Using the GlobeTrotter card for a DATA connection

Caution! Some Service Providers use automatic DNS Server assignment.

However if you can connect but have trouble opening a webpage we advise you

to enter the DNS settings manually. Please contact your Service Provider to obtain
the required DNS settings.

Depending on your network operator, a GPRS, GSM or UMTS connection might
already have been installed. If not, you will have to create a new connection following
the next steps. Click on Setup. Click on New to create a new connection.

SET]

P -

GETTING STARTED

You have to select which type of connection you want to set up.

e Wizard =
~which type of connection do you wish to create: |

@ GPRS/AG

CG5M

You choose either to import an existing connection or to set up a connection manually.

~ New connection:
® Impart an existing connection fram the GlobeT rotter Mability
Manaaer Database
) Set up my connection manually
[ <Back J[ _Mew> | [ cancel |

When you set up your connection manually right-click on the connection and select
rename. Enter a name for your connection (e.g. “My GPRS connection with Operator X”)
and fill in all the parameters of your GPRS connection. Enter the GPRS/UMTS settings

you received from your provider.



GETTING STARTED

In Name Servers (DNS) you can specify the DNS if required by your carrier.

B ]

In PDP type you can specify the PDP type. You can choose between [P and PPP. If required
by your carrier you have to fill in the address. (Typically the connection is type IP).

§ Modem - Lucent Win Modera [COM3)

&l m —
All devices cal the same rumbers

~Phane numbet ——————

fies code Phone number |

| Country/region code;
| z
[ Use dialing rules Diling Pules | |

[] Show icon in noification area when connected

O O
Gererdl | spcuny | Pavacy | Comtend | Connsctors | Frograme | Advanceg|
Hame page
'5 Addrerr ﬂm

Tempanry Inteinet fles
4 Piagess you vider on S Mnbairst ars oied in & special folder
i for cuack. viewary laer.

Didete Cocking..| [[Dielte Fie. | [ Setings...

_{} quick acoers b ecently viewed pager.
Cragps b oo pages in hiskory, 08 Eim_mg"""

| [ ] (e Langusges.. | [Aceassity. |
' o Ce )

GETTING STARTED

In Dial up Network you can modify the card

settings and the dial properties.

In Internet you can modify the internet

properties.

17



GETTING STARTED GETTING STARTED

In Quality of Service (QoS), you can change the QoS parameters. See the help files The Connection states tab

for definitions of the QoS parameters. Network status = Once that you are connected, F Connection dotais (7]
SUPERCOMM . SUPERCOMM

CAUTION! Do not change the QoS parameters unless your provider explicitly informs GSM v GRS e e SN EOE L et s
WLAN v show the connection statistics Sent  Receed

you to do so. Wolme: 233kB 456 kB

Speed 1.Bkbis 33kbss
Top speed 289kbss BOkbls

Which means:
Connected with (GSM/GPRS/UMTS)
Duration of the connection

Total volume of data transferred
Sent and received data volume

Current speed (upload and download)

>
>
>
>
>
> Top speed (upload and download)
Start a connection

Cuengimie | - 2 A connection can be started from:

e sattige |

> The connect button in one of the GTMM connectivity tabs

> From the Windows icon tray controller > right-click > "Connect using” for every
available connection

B R R Rl G/ GRS connection > From the Windows icon tray controller > left-click >”Connect” for the default connection

Setting up a GSM connection is similar to setting up a GPRS connection, so please refer

to the above steps.

All connections can be started from the GTMM controller icon in the taskbar.
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WLAN (only available on cards supporting WLAN) ManagingiProfiles

The configuration dialogue for WLAN profiles works like the configuration dialogue

BE]

for UMTS or GSM connections. The user selects the desired profile from the list at
DETION FEEE ﬁ-.-.- | wan S e -

the top and can modify the different parameters in the panes in the middle. Some

common operations are available in the tool bar at the bottom.

> To create a new profile, the user clicks the button “New” at the bottom of the

configuration screen. All settings in a new profile are set to their default values

Retwork statin

SUPERCOMM
08

until changed by you.

v

By clicking “Delete” the selected profile is removed from the list. A profile may be

Thers ivma spdscted prolie

deleted only if it's not currently being used for communication.

v

The user can save any changes to the current pane (including any changes to

other panes) immediately by clicking “Save”. This button is only available when

the data on the current or another pane has been changed.

NOTE: If you are using the profile that has been modified then the changes will not

First time using WLAN

g come into effect until you have stopped the connection and restarted it.
You can access the WLAN page by clicking:

> The WLAN button on the top toolbar
> The WLAN icon on the upper left navigation bar
> WLAN in the view menu

The WLAN page allows you to create, edit and configure a WLAN connection.
Also, when a connection is present, this can be started from there. In the top

of the screen you have a list of all available connections.



GETTING STARTED

WLAN Settings

This group of settings determines the communication parameters used on the air
interface. It's shown in a separate tab in the WLAN configuration dialogue. If an
authenticated connection to a wireless network is required, additional parameters

are needed that may interact with the parameters described in this section.

Profile name: INew profiie 1

Metwork name: l Scan
Hetwork type: Irfrastructure network. d

Chanrel [Feese |

Select the parameters for your wireless network, Shared kevs may be defined in the identity used in this
profile

WLAN | User | authentication |

> The user may either enter the network name or select it from a list which was
generated by clicking the Scan button. A network might not broadcast it’s name
for security reasons and so will not appear in the list, you will need it’s details
from your IT administrator.

‘Select Wireless Network |
List of available wireless networks
Name | Signal Stiength
) 5POwRTEAG-2 0%
P Dplion WLAN Intemnet 0%
P OSK Dlink 0%

GETTING STARTED

> The list of available networks is not updated automatically while this dialogue is
open, you must click “Scan”. While the scan is active a progress dialogue is shown.
Once the scan for networks is complete, all networks found are added to the pop-up
menu of available networks. For each network the following information is shown:
- Name of network
- Signal strength

> Selecting a network from the pop-up menu assigns the network’s name as well as
the network mode and the communication channel for point-to-point networks.

User Information

For WLAN networks that require user authentication you must define the user data within

the WLAN profile. The same information is used by all the supported authentication

methods. Additional WLAN profiles should be created if you want alternative user data.

> The user enters his data in the dialogue shown below. User data is only used
when authentication takes place. However, these settings can be entered even if
the currently selected authentication method does not use them.

> The field for entering a user name holds the user’s account name used for logging
into the wireless network. This usually different from the user’s real name
(e.g. “jdoe17” vs. “John Doe”). For a new profile the user name is set initially to
the account name of the current user.

Mew profile 1
! Use account name and passward [V Use certificate —
Account name: Certificate:
56t password explicitly - Sellct certificate
[ Enter your personal information for lagaing into a wireless
™ Clear text network, It is recommended ta use certificates instead of

passwards.

WLAM User | Authentication |



GETTING STARTED

> There are two fields for setting a password in a profile. The first determines
whether the password is contained in the profile or taken from the user’s
account information. Its possible values are “Prompt for password” and
“Use password”. The field for entering a password and the corresponding check
box are active only when “Use password” is selected.

> The field for the password does not show the password in clear text but as a
sequence of asterisks. As long as “Clear text” is checked, the password is displayed
in clear text. The check box is initially not marked.

> The field for the user’s certificate displays the “friendly name” of the certificate
selected by the user. This field is initially empty (i.e. no certificate is preselected).
A certificate is selected in the dialogue shown below. This list of certificates
shows all certificates for the current user. The list of certificates contains only

usable certificates, i.e. expired or are not yet valid certificates are not shown.

Authentication

Especially on wireless networks it is easy to gain physical access to the network.
Hence it is important to make sure that only the intended group of people is able
to use the network and any resources attached to it. The identity of the users has

to be checked and this is called authentication.

New profile 1

Authertication: WPAPoE - Encryption:

Preshared key: [

TKIP hd

[ Clear Text

Enter the key ko be used with WPA-PSK. The key may contain between 8 and 63 characters.

WLAN | User  Authentication

v

v

v Vv

GETTING STARTED

Different authentication methods (including “no authentication”) are supported.
Each method requires different authentication parameters. The user’s credentials
are taken from the corresponding page (see “User Information”) and are not specific
to a particular method of authentication. If the user selects a different method of
authentication, the user’s personal data are reused without resetting or changing it.
Communication over the air interface is usually encrypted. For some authentication
methods encryption of network traffic is required and cannot be turned off.

If such an authentication method is selected, the appropriate encryption method
is activated as well.

The supported methods of authentication are “Open”, “Shared”, “WPA-PSK”, and “WPA”.
The method of encryption is selected from a drop down list (e.g. None, WEP, TKIP,
and AES). This list is only available when it is allowed for by the selected method
of authentication. The dependencies between authentication method and

encryption scheme are shown here:

Open

Open authentication lets users attach to networks quickly as there is no access

control and encryption may be turned off. The amount of configuration is therefore

minimal. This mode is ideal for an ad-hoc network created for instance during

a meeting to exchange data or collaborate on a document. If encryption is set to

“None”, the files for entering WEP keys are hidden.

Shared

Shared authentication using WEP encryption provides weak security. If this method

has been selected, the user can either enter four shared keys.

>

The user can enter up to four different WEP keys. All entered keys must be
of the same length or the configuration is invalid. If the configuration is invalid,

the triggers a warning.
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> The user can enter a key either as a sequence of hexadecimal digits or as a string
of characters as defined by the format buttons above the key fields.
> As long as the user enters a key and the key’s length is not correct, an appropriate

warning is shown.

WPA-PSK

If the user selects authentication via WPA-PSK, he has to enter a so-called
pre-shared key. Such keys contain between 8 and 63 characters. The user may enter
these characters in an appropriate password field. The text of the key is shown
masked unless the check box “Clear text” is turned on.

Note WPA-PSK is a stronger encryption method than WEP, users are advised to use
WPA-PSK whenever possible. The amount of configuration is essentially the same

while WPA-PSK is more secure without the need for a dedicated authentication server.

WPA-PSK
On the WPA settings pane, the user selects the method of authentication used when
the device communicates with a RADIUS server. RADIUS serves are typically used in

a corporate environment.

> The method of authentication is selected from the “Main Protocol” pop-up menu.

The following bullets describe in more detail additional parameters that might

be necessary for the different methods:

- EAP/LEAP This protocol does not use any additional parameters.

- EAP/PEAP This protocol uses certificates for authentication. By setting the appropriate
check box, the user may request a verification of the server’s certificate.

- EAP/SIM This protocol does not use any additional parameters. The user’s SIM
must be present when he wants to attach to a WLAN network. Usually

the user enters the SIM-PIN when the main application is started.

GETTING STARTED

If the user did not enter the SIM-PIN when the main application started,

the main application prompts the user for the SIM-PIN using the usual dia-
log for entering a SIM. The main application can simply check whether the
SIM-PIN is needed when the user tries to open a connection with EAP/SIM as
its authentication method and prompt the users as appropriate.

- EAP/TokenCard This protocol does not need any additional parameters.

- EAP/TLS This protocol uses certificates for authentication. The user must select
a personal certificate for this method to work. If there is no certificate selected,
this triggers a warning. The only additional parameter for this method
is whether the server’s certificate should be verified.

- EAP/TLS This protocol uses a certificate for authentication.

My Options

* My OPTIONS j‘

3 Messenger
& Internet

S WS FTP

Custornize Toolbat, ..

Using the GTMM My Options button you can add shortcuts to your favorite applications.
The drop down list gives immediate access to all applications that you have added.
You can consider My Options button as an extension of the main toolbar.

From the menu View > Customize Toolbar it’s possible to choose which buttons
you want to appear in the Toolbar and in the My Options list. Or you can also do it
in ‘My Options / Customize Toolbar...’
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Configuration settings

The configuration tabs are accessible from:
> GTMM controller > Left Click > Settings > Configuration

> Menu bar > Tools > Configuration

Airplane mode

Airplane mode allows the user to safely use other functions of a wireless device
(such as WLAN functions) on an airplane during flight. All Option GlobeTrotter cards

together with the Mobility Manager software will support airplane mode.

ONLY THE FIRST TIME that the software is started and a card is detected the following
pop up will appear:

5 Setti ngs

 Anplane Mode | Miosoft Dutioak | Band sslection | Metwark | Connestion type |

IMPORTANT HOTES ON AIRPLANE MODE

This data card supports an Airplane Mode. This prevents the Radio Interface
from operating until the Radio Interface is switched on by you

With Airplane Mode enabled, your GlobeTrotter data card will not register,
1eceive SMS, report signal strength or llw dats connections until you enable
the Fiadio Intsiface:

“with &irplane Mode enabled, you will stil be able to use Wi if this data card iz
fitted with it. This will allow the use of WiFi where services are provided but
where mobile phones must be switched off (some Hospitals and Airplanes
provide this service)

This ensures you can boot your PC safely without having to remave the data-card
from its shat.

Donot enable insi here theuse of moble
h - hibi

d_Al follow local lations and laws

issue.

[] Enable Airplane Mode at Startup

&) (e )
J
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a) If the user choose <Enable Airplane Mode>, the card will be powered down.
Therefore, as specified into the pop up, the card will not register and the user will
not be able to make an Internet dial up connection or send/receive SMS.

In the network status pane, a message will remind the user that Airplane Mode
is enabled.

The message will be shown every time that the GPRS radio is off

(FOR CARDS SUPPORTING AIRPLANE MODE!)

Network status s
AIRPLANE MODE

] |
x

b) If the user chooses <Disable Airplane Mode>, then the GlobeTrotter datacard
will behaviour normally. It will just register after the insertion of the PIN and

it will allow connections and messaging.

Important note for GlobeTrotter COMBO EDGE card users:

In the GlobeTrotter COMBO EDGE card the GSM radio is by default off. You will need

to manually turn the radio on. You can do this via:

a) GTMM > Tools > Settings > Airplane Mode (or controller “Right click” > Settings >
Airplane Mode)

b) Controller> “Right click” > Enable GPRS Radio (or Tools > Enable GPRS Radio).
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GETTING STARTED

Security Network operator selection
The network operator selection window displays a list of available networks and
selects the chosen network provider from the list.
M
firplane Made | Microsolt ullosk; | Band selection| Metwork | Connection type |
Opt Mar | Twp
-DK -_Eancal i
Mabistar Available GSM/GPRS
PROXIMUS Available [selected) GSM/GPRS
PROXIMUS Avvailable [selected) 3G
The following passwords can be changed:
> SIMPIN
> SIM PIN2

Change a password: the old password must be entered and the new password
is entered twice.

5 EGEE | ro"er HDEIII!Y Hana.ger

| File Edit view

Enable PIN-code

Change PIN-codes ...

Connection history...

3 Settings... To check the current settings and read the current list of networks, click Query. The list
Diagnostics...
Settings... displays all available networks. The operator’s status is shown in the second column.
Disable GPRS Radia To register with a different operator, highlight the Operator name, click Select and click OK
- Selecting an operator switches the GlobeTrotter to manual registration mode; it will
code:

try to register with the selected operator only. To go back to automatic registration,

If PIN-code is enabled, PIN must be entered any time a new connection to the network ) 4
you must click Automatic.

is initiated after the device has been turned off.
If PIN-code is disabled, you don’t need to give in the PIN-code after the device has
been turned off.
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Diagnostic Utilities

A general diagnostic tool which will check the basic settings like installation,

network availability, signal strength...

f «** Diagnostic Tool

&

1§ Hardware Test

£ COM Part

4 Fimnware wersion

4 Hardware version

& FPGA version

O MAC Address

£ IMEI number

@ Dwn phone number

4 IMSI number

@ Serial number

A Server version

© Diiver version

% Operational test

£ PIN cade status

4 Network operator

& Network selection mode
4 Signal strength

% GPRS Settings

4 GSM Metwork registration
4 GPRS Nebwork registration
4 GPRS Network attachment
& AFN

i WLAN Settings

O WLAN available in range

&l

COm24

221d [Date: Sep 13 2004, Time: 11:46:00)
21

n/a

néa
3539200004207 21
néa
20B017700539795
RC2047G0CT

nta

nis

PIN Ready
FROXIMUS [20601)
Automnatic

210

Fiegistered

Registered

Attached

1.1P" Mintemet prosimus. be'", 0,0

nfa

m \ B

T

Bt | Copy |[  Save |

Connection History, another advanced diagnostic utilities is accessible from

within GTMM.

TROUBLESHOOTING

This section points out the basic problems that could occur when you are installing
and using the card. There is a list of symptoms and possible actions you can take in
any of the following situations below.

Not enough disk space for installation.

There is not enough space to complete the installation on the selected drive.

Select another drive for installation or delete unnecessary files to free up additional
disk space. If there are several hard disk drives in the system and you decide to
install the program on a drive other than the one where the Windows system files
are located, disk space is required on both drives. The program will always need to
place some files in the Windows directory.

Setup does not accept the target directory.

The program can only be installed on a local drive. If the path to the directory is
over 80 characters, it will not be accepted. Select another directory or shorten
the names of the subdirectories.

The GlobeTrotter card cannot be installed or used.

The Interrupt Request (IRQ) resources may be in conflict. Check the GlobeTrotter
resources from Control Panel/System/Hardware/Device Manager.

If there is a resource conflict, consult the Windows online help on changing

the resource settings.

The GlobeTrotter card is not properly inserted.

Make sure that the PC Card slot or the computer is functioning properly and that
the GlobeTrotter drivers are installed (In Control Panel > Ports).

Also make sure that the SIM card has been inserted.

Refitting the antenna (Only for cards
with replaceable antenna’s)

When the antenna becomes disconnected, refit it as follows:



SAFETY INFORMATION

Read these simple guidelines. Breaking the rules may be dangerous or illegal.

Further detailed information is given in this manual.

Driving: Do not use the GlobeTrotter while driving; park the vehicle first.
Interference: All wireless devices may get interference, which could affect performance.
Do not use in hospitals: Follow any regulations or rules. Do not use near medical
equipment.

Do not use in airplane: Wireless devices can cause interference. Using them on air-
planes is illegal.

Do not use near refueling points: Do not use the device at a refueling point. Do not
use near fuel or chemicals.

Use sensibly: Do not touch the antenna unnecessarily.

Use qualified service: Do not attempt to dissemble GlobeTrotter. Doing so will void
warranty. Service should only be performed by Authorized Service Centers.
Accessories: Use only approved accessories. Do not connect incompatible products.
Liquids: Do not expose your card to rain, or spill beverages on it.

Extreme temperatures: Do not expose the card or the antenna to extreme tempera-
tures, below -25 or over +70 degrees Celsius.

Traveling: Handle the card with care while traveling. It is recommended to remove
the card from the laptop.
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